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Software License Agreement
Carefully read the following terms and conditions sign and return as accepting
these terms and conditions.
This is a legal agreement between you, the end user (either an individual or an
entity), and Scanvec Amiable, Inc. If you do not agree with the following, you
should promptly return the package. Use of this program indicates your
acceptance of the terms and conditions stated below.
1. License.
The enclosed computer program "Software" is licensed, not sold, to you by
Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only
under the following terms, and Scanvec Amiable, Inc., reserves any rights not
expressly granted to you. You may not disclose to any third party any
confidential information concerning the Software or Scanvec Amiable, Inc. or use
such confidential information to the detriment of Scanvec Amiable, Inc...
This software is protected by the United States Copyright Law and International
Treaty Provisions. Therefore, you must treat the Software just as you would any
other copyrighted material, such as a book. This license allows you to:
(a) Make one copy of the Software in machine readable form; provided
that such a copy of the original may be used solely for backup purposes.
As an express condition of this License, you must reproduce on each copy
of the Scanvec Amiable, Inc., copyright notice and any other proprietary
legends on the original copy supplied by Scanvec Amiable, Inc.
(b) Transfer the Software and all rights under this License to another party
together with a copy of this License and all written materials
accompanying the Software provided you give Scanvec Amiable, Inc.,
written notice of the transfer and the other party reads and agrees to
accept the terms and conditions of this License.
(c) Use this Software on a single computer only, but may transfer it to
another computer as long as it is used on only one computer at a time. “In
Use” constitutes being loaded onto either temporary (i.e., RAM) or
permanent memory (e.g., hard disk, CD-ROM or other storage device) of a
computer.
2. Restrictions.
You may NOT distribute copies of the Software to others or electronically transfer
the Software from one computer to another over a network. You may not decompile, reverse engineer, disassemble or otherwise reduce the Software to a
human perceivable form. You may not modify, adapt, transfer, rent, lease, loan,
resell for profit, distribute, network or create derivative works based upon the
software or any part thereof.
3. Termination.
This License is effective until terminated. This License will terminate immediately
if you fail to comply with any of its provisions. Upon termination, you must return
the Software, and all copies thereof, to Scanvec Amiable, Inc., and you may
terminate this License at any time by doing so.
4. Export Law Assurances.
You agree that neither the Software nor any direct product thereof will be
transferred or exported, directly or indirectly, into any country prohibited by the
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United States Export Administration Act or any international export laws and the
restrictions and regulations thereunder, nor will it be used for any purposes
prohibited by the Act or laws.
5. Warranty Disclaimer, Limitation of Remedies and Damages.
In no event will Scanvec Amiable, Inc., be liable for any damages, including
infringement, lost data, lost profits, cost of cover or other special, incidental,
consequential or indirect damages arising from the use of the program however
caused and on any theory of liability. This limitation will apply even if Scanvec
Amiable, Inc., or an authorized dealer or distributor has been advised of the
possibility of such damage.
SCANVEC AMIABLE, Inc. MAKES NO
WARRANTY, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE,
AND DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE. Scanvec
Amiable, Inc., does not warrant any drivers for plotting, scanning or either
devices. These drivers are provided for our customers as a service only, and
were developed using information provided to us at the time by the equipment
manufacturers.
Scanvec Amiable, Inc., is not responsible for any typographical errors in the
software or in the documentation.
6. General.
If you are a U.S. Government end-user, this License of the Software conveys
only "RESTRICTED RIGHTS," and its use, disclosure, and duplication are
subject to Federal Acquisition Regulations, 52.227-7013(c)(1)(ii). This License
will be construed under the laws of the State of Pennsylvania, except for that
body of law dealing with conflicts of law, if obtained in the U.S., or the laws of
jurisdiction where obtained, if obtained outside the U.S. If any provision of this
License is held by a court of competent jurisdiction to be contrary to law, that
provision of this License will remain in full force and effect.
© Copyright 2002 by Scanvec Amiable, Inc. All rights reserved. No part of this
publication may be reproduced, stored in a retrieval system or transmitted, in any
form or by any means, electronic, mechanical, photocopy, recording or
otherwise, without the prior written permission of the publisher. Printed in the
United States of America. The information in this manual is subject to change
without notice and does not represent a commitment on the part of Scanvec
Amiable, Inc.
Acrobat® Reader Copyright© 1987-2002 Adobe Systems Incorporated. All rights
reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated
which may be registered in certain jurisdictions. PostScript®
software
Copyright© 1984-1998 Adobe Systems Incorporated. All rights reserved.
Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FlexiEXPERT, FlexiSIGN,
FlexiLETTER, FlexiDESIGNER, FlexiCUT, FlexiENGRAVE, PhotoPRINT Server,
PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRouteMachine Shop, and/or other Scanvec Amiable products referenced herein are
either trademarks or registered trademarks of Scanvec Amiable, Inc. Illustrator is
a registered trademark of Adobe Systems Incorporated. FreeHand is a registered
trademark of Macromedia Corporation. CorelDRAW! is a trademark of Corel
Systems Corporation. AppleTalk, ImageWriter, LaserWriter, and Macintosh are
registered trademarks of Apple Computer, Inc. Windows is a registered
trademark of Microsoft Corporation. The names of actual companies and
products mentioned herein may be the trademarks and/or registered trademarks
of their respective owners. Adobe® is a trademark of Adobe Systems
Software License Agreement
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Incorporated or its subsidiaries and may be registered in certain jurisdictions.
PostScript® is a trademark of Adobe Systems Incorporated or its subsidiaries
and may be registered in certain jurisdictions.
Scanvec Amiable, Inc.
International Plaza Two, Suite 625
Philadelphia, PA 19113-1518
License Agreement for Users of Adobe® Configurable PostScript® Interpreter
and Coded Font Programs
1. Licensor grants to Licensee a nonexclusive sublicense, subject to Paragraph 7
below and the other provisions hereof (a) to use the CPSI Application Object
("Software") solely for Licensee's own internal business purposes in a single
central processing unit ("CPU"), optional associated display with a resolution of
less than one hundred fifty dots per inch, and, optionally, connected to a single or
multiple output device (the "Computer System"); (b) to use the digitally-encoded
machine-readable outline programs ("Font Programs") provided by Licensor in a
special encrypted format ("Coded Font Programs") and identified herewith to
reproduce and display designs, styles, weights, and versions of letters, numerals,
characters and symbols ("Typefaces") solely for Licensee's own customary
business or personal purposes on the Computer System; and (c) to use the
trademarks used by Licensor to identify the Coded Font Programs and
Typefaces reproduced therefrom ("Trademarks"). Licensee may assign its rights
under this Agreement to a licensee of all of Licensee's right, title and interest to
such Software and Coded Font Programs provided the licensee agrees to be
bound by all of the terms and conditions of this Agreement.
2. Licensee acknowledges that the Software, Coded Font Programs, Typefaces
and Trademarks are proprietary to Licensor and its suppliers. Licensee agrees to
hold the Software and Coded Font Programs in confidence, disclosing the
Software and Coded Font Programs only to authorized employees having a need
to use the Software and Coded Font Programs as permitted by this Agreement
and to take all reasonable precautions to prevent disclosure to other parties.
3. Licensee will not make or have made, or permit to be made, any copies of the
Software or Coded Font Programs or portions thereof, except as necessary for
its use with a single Computer System hereunder. Licensee agrees that any such
copies shall contain the same proprietary notices which appear on or in the
Software or the Coded Font Programs.
4. Except as stated above, this Agreement does not grant Licensee any rights to
patents, copyrights, trade secrets, trade names, trademarks (whether registered
or unregistered), or any other rights, franchises, or licenses in respect of the
Software, Coded Font Programs, Typefaces, or Trademarks. Licensee will not
adapt or use any trademark or trade name which is likely to be similar to or
confusing with that of Licensor or any of its suppliers or take any other action
which impairs or reduces the trademark rights of Licensor or its suppliers. The
Trademarks can only be used to identify printed output produced by the Coded
Font Programs. At the reasonable request of Licensor, Licensee must supply
samples of any Typeface identified by a Trademark.
5. Licensee agrees that it will not attempt to alter, disassemble, decrypt or
reverse engineer the Software or Coded Font Programs.
6. Licensee acknowledges that the laws and regulations of the United States
restrict the export and re-export of commodities and technical data of United
States origin, including the Software or Coded Font Programs. Licensee agrees
that it will not export or re-export the Software or Coded Font Programs in any
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form without the appropriate United States and foreign government licenses.
Licensee agrees that its obligations pursuant to this section shall survive and
continue after any termination or expiration of rights under this Agreement.
7. The Software licensed hereunder may be used to generate screen displays on
a single Computer System having a screen resolution of less than 150 dots per
inch and to generate output on the associated output device. Licensee agrees
not to make use of the Software, directly or indirectly, (i) to generate bitmap
images on a screen display with a resolution of 150 dots per inch or greater, (ii)
to generate Typefaces for use other than with the Computer System, or (iii) to
generate printed output on other than an output device that Licensor has
designated to be approved for use with the Software on the Computer System.
Any failure of Licensee to comply with this provision is a material breach of this
End User Agreement.
8. NEITHER LICENSOR NOR ANY OF ITS REPRESENTATIVES MAKES OR
PASSES ON TO LICENSEE OR OTHER THIRD PARTY ANY WARRANTY OR
REPRESENTATION ON BEHALF OF LICENSOR'S THIRD PARTY
SUPPLIERS.
9. Licensee is hereby notified that Adobe Systems Incorporated, a California
corporation located at 345 Park Avenue, San Jose, CA 95110-2704 ("Adobe") is
a third-party beneficiary to this Agreement to the extent that this Agreement
contains provisions which relate to Licensee's use of the Software, the Coded
Font Programs, the Typefaces and the Trademarks licensed hereby. Such
provisions are made expressly for the benefit of Adobe and are enforceable by
Adobe in addition to Licensor.
10. The Adobe Postscript Interpreter includes an implementation of LZW licensed
under U.S. Patent 4,558,302. The Adobe® PostScript© Interpreter, also referred
to as CPSI, is provided on an as is basis. Scanvec Amiable, Inc. is not
responsible for any damages arising from the use of the program however
caused and on any theory of liability.
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1. Installing the Software
Before you begin installing the software, read the hardware
requirements below. For optimal performance we suggest that your
system meet the recommended requirements. As with all computer
software, systems with faster processors, more RAM, and greater
amounts of storage space allow you to work with larger files and keep
your processing time to a minimum.

Recommended System Requirements
Windows

Processor

Macintosh

Pentium II 350 MHz

G3 300 MHz

RAM

256 Mbytes

Install Space

200 Mbytes

Working
Space

Disk

Operating
System

4 Gbytes
Windows 98 / ME /
Windows NT4.0 / 2000 / XP

Video

MacOS 9.x / OSX 10.2

800x600 resolution monitor with 16 bit color
4x CD-ROM or DVD Drive

Other

Free USB or LPT Port for
hardware key

Free USB Port for
hardware key

Available Port for Output Device
Windows NT 4.0 requires Internet Explorer 5.x or greater & Service Pack 4
or higher.

Installation Procedures
The software will not run without a hardware protection key, also known
as a dongle. The hardware key protects the software from being
unlawfully copied and must be connected to your computer whenever
you use the software.
There are three types of hardware keys: Parallel, ADB and USB keys.

Parallel key
(Windows only)

Installing the Software

ADB key (Macintosh
only)

USB key
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Installing a Hardware Key
1. Turn off your computer.
2. Plug the hardware key into the port (USB, LPT or ADB).
3. Turn on your computer
When using parallel port keys, we recommend that you plug your output
device and key into separate parallel ports.

Installing the Software
Windows Installation
Follow these steps to install the software:
If you’re installing on a PC running Windows NT/2000/XP, you must have
Administrator privileges. See your Windows user guide for details.

1.

Insert the Installation CD.

2.

Select a language and then click OK.

3.

Enter your user number and password and then click Next. The
User number and password can be found on the product hardware
key.

4.

Select the product and language to be installed and then click Next.

5.

On the Welcome screen, click Next to continue.

6.

Read the Software License Agreement and click Yes to accept.

7.

Click Yes to view the Readme file.
The Readme file contains last-minute issues and information that are not
included in this documentation.

8.

You may change the default destination folder here. Click Next.

9.

Select the folder where the software will be included. If you accept
the default folder, a new folder will be created for the product. Click
Next.

10. Click Yes to clear the preferences.
11. Select the printers you want to install color profiles for then click
Next.
12. Select Yes and click OK to restart your computer.
By default, the installation program places a shortcut to the software in the
Windows Startup folder. Each time Windows starts up, the software will be
loaded and minimized, and its icon will appear in the System Tray area of
the Windows Taskbar. To prevent the software from being loaded
automatically, delete the shortcut in the Startup folder. To shut down the
software, right-click on the icon in the system tray and select Exit.
Page 2

Installing the Software

Macintosh Installation
1.

Insert the Installation CD into your CD-ROM drive.

2.

Double-click the Installer icon.

3.

Select the Installer language from the Installer window.

4.

Click OK. The system displays the Installation Options window.

5.

Select the product you would like to use from Product drop-down
box.

6.

Select the language you would like from the Language drop-down
box.

7.

Click OK.

8.

Accept the default selection of Easy Install and specify the location
to install the software. Click Install when you are finished.

Note: If you currently have the software on your system the Clear
Preferences window displays. Click Yes to delete preference
settings on your system. Click not to retain your old preference
settings.
Please launch Adobe PostScript Driver Installer.
Installing AdobePS Driver for a Macintosh
1. Locate the AdobePS Installer folder.
2.

Select the language folder you would like to install.

3.

Double-Click on AdobePS Installer icon.

4.

After reading the License agreement click on Accept to continue.

5.

Select the Install location from the Install Location drop-down box.

6.

Click Install.

7.

Click Restart.

8.

Reboot your computer.

Setting up the Software
1. Double-Click on the icon for the software.
2.

Select a printer model.

3.

Click Next.

4.

Select the port type you would like to use. You may choose USB or
TCP/IP port.

5.

Click OK.

Creating a Desktop Printer
1. From the Apple menu select Chooser and then highlight AdobePS.
Installing the Software
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2.

Locate your PostScript printer. It should say <Printer
Name>@Computer, “Computer” is the name of your Macintosh.

3.

Click Create. You are prompted to select a PPD (PostScript printer
description).

4.

Click OK.

5.

Select Standard Memory.

6.

Click OK.
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2. Configuring the Software
The illustration below shows some of the basic elements in your
software:

Toolbar

Job
Area

Basic Elements of Your Software
Queue Column Headings
Job Name

The name of the file, followed by its internal PostScript
name in parentheses.

Status

The current status of the job.

Copies

The number of copies to be printed.

Media

The type of media specified.

File type

The format of the file.

Toolbar
A toolbar is located at the top of the main window. It contains tools for
the most commonly used functions.
To show or hide a toolbar, select Toolbar from the View menu.
The toolbar functions are:
Add Job

Adds a job to the selected output device.

Save As

Saves the selected job to a file.

Send
Job

Sends the selected job to the specified output device,
RIPing it if necessary.

Abort

Stops selected file from RIPing or printing.

Delete

Deletes the selected job or jobs.

Configuring the Software
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Setting Up Output Devices
When you first open the software you are prompted to add a setup for
an output device. To add setups for any additional output devices, go to
the Setup menu and select Add Setup.

Adding New Setups
To add new setups:
1.

From the Setup menu, select Change Setup.

2.

Select either Color Printers or Hybrid Devices.

3.

Select the manufacturer of the output device from the
Manufacturer list.

4.

Select the model of the output device from the Model name list.

5.

Click on the Next button to continue.

6.

Select the Port the output device uses for communication.

7.

Click the Finish button to finish adding the setup.

8.

You will be prompted to install a PostScript printer driver. This
driver forms an integral part of the output device setup. Click OK to
install the driver.
On Windows XP/2000, your system will automatically be configured with a
PostScript printer. On Windows 98/NT, follow the on-screen installation
instructions in the printer driver installer:

a.

In the Welcome screen, click Next.

b.

Click ACCEPT to accept the end user license agreement.

c.

Select Install a new PostScript printer and click Next.

d.

Under Printer Connection Type, select It is directly
connected to your computer (Local Printer) and click Next.

e.

Under Local Port Selection, click Next to accept the default
printer port.

f.

Under Select Printer Model, click Browse and select the
C:\Program Files\[Software]\PPD folder. Select the printer
model and click OK. Click Next to continue.

g.

Select Not Shared and click Next to continue.

h.

Click Next to accept the default name and settings.

i.

Click Install to install the generic PostScript printer driver.

j.

Select No to avoid further configuration and click Next.

k.

Clear the Yes, I want to read the ReadMe file box and click
Finish to finish the generic PostScript driver installation.
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l.

Click Yes to reboot your computer.

Setting Up Desktop Printers as Output Devices
To set up a conventional printer as an output device:
1.

Add the printer to the computer as a standard Windows printer.

2.

When creating the setup in the software, select Desktop Printer
under Manufacturer, then select the print queue for the desktop
printer under Model name and click Next.
If the output device is a desktop printer, the Port list will be disabled.

3.

Click Finish to complete the setup. You will be prompted to install a
PostScript driver. Click OK to install the driver.
The steps for installing the PostScript printer are identical to those on page
6.

Editing Setup Properties
To edit the setup properties associated with a particular output device,
from the Setup menu, select Setup Properties.
•

Right-click the setup icon in the Setup Pane and select Properties.

•

Select the setup icon in the Setup Pane, then

•

Double-click the setup icon in the Setup Pane.

Setup Properties - General Tab
The General tab displays information about the output device, media
size and port.
Manufacturer

Manufacturer of the output device.

Model

Model of the output device.

Setup name

Name of the setup.

Hot folder

The folder that the software will use to store job files
for this output device.

Port

Select the port to which the output device is
connected:
COM

Serial communication port. This port
is only supported by cutters.

FILE

File port allows you to save the
output data as a file.

FTP

Output devices that supports network
connection may support FTP
protocol. You are required to enter
the IP address assigned to the output
device.

Configuring the Software
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LPR

Some network devices do not work
with TCP/IP and only with LPR
protocol. You are required to enter
the IP address assigned to the output
device.

LPT

Parallel port is the most common
method to connect printers to the
computer.

SCSI

Use this port if your output device
supports SCSI connection.

TCP/IP

Use this port if your output device
supports network connection. You
are required to enter the IP address
assigned to your output device.

USB/FireWire

USB/FireWire drivers are provided
with output devices that support
them. Please make sure the proper
drivers are installed when using
these ports.

Browse

Allows you to locate the printer shared on the network
and select it as an output port.

Media

Select a media size that is currently loaded in your
output device. You can specify custom media sizes by
selecting Custom size from the list and then entering
the Width and the Height values. Width and Height
display the size of the media being used and not the
actual output area.

Margin

Displays the margin settings for the selected media
size. Changing the margin value will not affect the
position where the output will be done. Margin values
are only used to calculate the output area.

Setup Properties - Print Tab
The Print tab displays the settings related to the printing. The layout of
this tab may differ depending on the output device. On some output
devices, the settings will adjust automatically to its best settings as you
change some settings. Some settings may require manual adjustment.
Media

Select the media type the output will be printed on.

Print mode

Select the print quality for the output.

Resolution

Select the output resolution.
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Driver
Options

Clicking this button displays the Driver Options dialog.
The Driver Options dialog contains settings specific to
the output device. Most of settings in the driver options
can also be set through the output device’s panel. See
your output device manual for more details.

Dither type

Select the dithering for the output.
Dither Type is the pattern in which the individual dots
that make an image are applied to the media. Each
dither type has advantages in terms of quality and RIP
speed. The default dither type is usually the best setting
for your machine.
The software offers several dithering options to optimize
your output. Usually, quality and speed are in tradeoff,
with KF Diffusion offering the highest quality and the LX
Diffusion or FMXPress offering the fastest processing
times.
The list of available patterns is in descending order of
quality and ascending order of speed.
Error
Diffusion

This method produces high-quality
images. The enhanced image quality
requires intensive processing (3-4 times
more than FMXPress), and the time it
takes to RIP a file using this method is
the second longest of the available
options.

LX
Diffusion

A faster option as far as RIP times are
concerned. It’s a good choice for large
prints that will be viewed from a
considerable distance.

FMXPress

The default diffusion method. It’s the
fastest in terms of RIP time and is
suitable for most prints.

Angled
Screen

Designed for use with thermal printers to
produce vibrant, saturated colors. This is
also used to produce screen print
positives. Click Screen to set advanced
options.

Perform
color
correction

Checking this option activates the color correction
settings. If this setting is not checked, incoming jobs are
assumed to have already color corrected in the design
application.

Use
embedded
ICC profile

Checking this option forces the RIP to use the ICC
profile information embedded in the job file.

Configuring the Software
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ICC input
profile

Select the ICC input profile to use to convert the image
into a neutral color space. If you are not familiar with
color management theory, use the default values. To
add an ICC input profile from another source, click the
Add button. There are three types of ICC input profiles
that can be specified.
CMYK

The CMYK input profile applies to all elements
of a job that are in CMYK color mode. If your
image is in CMYK color mode, then your file
was previously separated for output to a
specific output device. Whenever is possible,
use the profile used for separation in your
design application as the CMYK input profile.
Try using similar profiles for common ink sets
(such as CMYK SWOP or High End SWOP) if
you don’t have the matching profile.

RGB

The RGB ICC input profile applies to all
elements of a job that are in RGB color mode.
An RGB input profile can be for either a
monitor or a scanner. If you scanned your
image without color correcting it, it is
recommended to use the scanner profile as a
RGB input profile. If you have done any onscreen color correction, you should select
your monitor profile as a RGB input profile.

Gray

The Gray ICC input profile applies to all
elements of a job that are in grayscale color
mode. This may refer to either a grayscale
scanner or a grayscale monitor.

ICC output
profile

Once the image is in a neutral color space, the output
profile is used to convert the image into the color space
of the output device.
Select the ICC profile that matches the combination of
ink, media, resolution, and dither type of your output
device.
To add an ICC output profile from another source, click
the Add button.

Bitmap and
Vector
rendering
intent

Rendering intent specifies how a color space from the
input file gets mapped to the color space of the output
device. The rendering intent selected in the Bitmap
rendering field will be applied to bitmap images (raster
images) in your job file. The rendering intent selected in
the Vector rendering intent field will be applied to vector
objects (shapes, text, etc). Choose from one of the
following rendering intents:
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Perceptual

This intent is best for photographic
images. Colors outside of the output
device’s gamut are either clipped or
compressed to fit the output device’s
color space.

Saturation

This intent is best for graphic images,
such as vector art, where vivid colors
are more important than true color
matching. Colors outside of the output
device’s gamut are mapped to colors at
the extent of the gamut’s saturation.
Colors that fall within the gamut of the
output device are shifted closer to the
gamut’s saturation extent. This
rendering intent may also be used to
boost colors within a photographic
image.

Relative
Colorimetric

This intent is best for images, such as
logos, where the output needs to match
the original image. Colors that fall
outside of the output device’s gamut are
clipped. This method may reduce the
total number of colors available. The
white point of Relative Colorimetric is
always zero

Absolute
Colorimetric

This intent is similar to Relative
Colorimetric, but has a different white
point value. Absolute Colorimetric
represents colors relative to a fixed
white point value of D50. For example,
the white of paper A will be simulated
when printing on paper B. This intent is
best for color proofing.

Spot Color

This intent was created to supplement
the Saturation intent. Spot Color maps
colors similarly to the Saturation
rendering intent, but Spot Color
rendering intent produces the greatest
saturation possible, and should not be
used with photographic images.

Info

Clicking this button displays the Profile Properties
dialog. This dialog displays detailed information of the
selected output profile. Use this to check whether the
selected profile matches your media.

Color Mode

Select the color mode that matches the inks set in the
printer.

Configuring the Software
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Setup Properties - Cut Tab
The Cut tab allows you to specify settings related to cutting. Some
settings specific to certain cutters are not described here. Please
consult your cutter manual for more details.
Resolution

Set the resolution of your cutting device. The default
value is already set for optimal results. You should not
change this value unless you are experiencing
problems with your output (output size not matching
the size it was designed).

Passes

Specify how many times the blade will move over each
line

Advance
after plot

Check this option to advance the media after output
and reset the origin.

Curve
quality

Select how smooth you want the curves to be. The
default is already set for optimal results.
Best

Produces the smoothest curves but process
will be slower.

Faster

Produces faster output with lower quality.

Draft

Produces the quickest output with lowest
quality.

User

Allows you to set your own accuracy of
paths.

Send arc
commands

Activates the device’s internal curve handling.

Knife offset

Allows you to enter custom values for knife offset.
Usually knife offset should not be changed from the
software. You should use the offset settings in the
cutter.

Send
packets

Specify the packet size sent to the device. This setting
only applies to a limited number of cutters and you
should not change unless your cutter requires it.

Reset

Restores the default settings.

Cutter Driver
Options

Displays the Cutter Driver Options dialog.

Setup Properties - Communication Tab
The contents of this tab vary according to the port used to connect to
the output device.
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COM

Allows you to set the communication parameters (speed, data
format) for serial communication. The default settings should
already be properly set to work with your output device.

FTP

Allows you to set the IP address assigned to your output
device and the Printer/Queue name

TCP/IP

Allows you to set the IP address and Port number assigned to
your output device.

FTP or
LPR

Allows you to set the IP address and Queue name assigned
to your output device.

LPT

Allows you to set the timeout settings for the parallel port.

SCSI

Allows you to set SCSI IDs for your output device.

Setup Properties Color Tab
The Color tab provides some basic tools to manually adjust the output
color. Move the slider to the left or right to decrease or increase
respectively the amount of that color in the output.
All

Allows you to quickly adjust all color channels as a group.

Contrast

Adjusts the contrast of the image.

Reset

The reset button will restore the values and settings to their
original state.

Setting Application Preferences
The Preferences dialog box lists global settings for the application.
To display application preferences, from the Edit menu select
Preferences.

Application Preferences General Tab
The General tab contains preferences for the software.
After Output

Sets what to do with the job after output:
Delete

Removes jobs from the queue after output.

Hold

Places jobs in the Hold Queue after output.

Units

You can specify what units of measurement will display
by selecting the desired units from the list.

Enable
simultaneous
RIP and Print

If this option is selected, the software will RIP and print
the job simultaneously. RIPing and printing
simultaneously may affect overall performance.

Configuring the Software
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3. Processing Print Jobs
Adding Jobs
Jobs can be added to the queue in the Jobs Area in a number of
different ways.
The file must be of a supported file type. See Appendix A for the list of
supported file types.

Copying the File to the Jobs Folder
The Jobs folder is a file folder used to store all the files that are queued
up for printing. It is located in the base folder for the software. Whenever
a job is copied or moved into the Jobs folder, it will automatically be
added to the queue in the Jobs Area.

Adding the Job from Within the Software
Carry out the following steps to add a job to the queue in the Jobs area:
1.

From the File menu, select Add Job.

2.

Select the file to be added and click Open.

Dragging a File into the Software
Dragging a file into the software will automatically add it to the queue in
the Jobs area. To do this, select the icon for the file in another program
such as Windows Explorer, and drag the icon from that window into the
Jobs area of the main window.

Setting Job Properties
Understanding Job Properties
Job properties overrride setup properties.

Setting Job Properties Using the Job Properties Dialog
To access the Job Properties dialog, select the job and do one of the
following:
•

Double-click on the job.

•

From the File menu, select Job Properties.

•

Right-click on the job and select Job Properties from the context
menu.

Different tabs within the Job Properties dialog let you set general
properties for the job, layout options, Tiling/paneling options, color
calibration options, color adjustment options and labels. For certain
jobs, the contour cut options will also be available. Settings in Job
Properties only apply to the selected job.
Processing Print Jobs
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Job Properties - General Tab
Media Size

The size of the material loaded in your output device.
Media Size displays the size of the media being used,
not the total printable area. The printable area on the
media will be slightly less than the actual area.

Size

Choosing one of these options allows you change the
output size and orientation of the page.
Width/ Height

Accepts direct entry of the job's width
or height. When one aspect is altered
the other is automatically updated to
keep the job proportionally correct.

Scale

Is used to increase or decrease the
job's size as a percentage of the
original. In most cases, a job's size
should be controlled from within the
application in which it was created to
prevent unexpected results.
Flips the selected image on the
vertical axis, so that your image will
be ‘mirrored’ when printed.
Rotates image on the media in 90degree increments. Click the rotate
button until you achieve the desired
orientation.

Proportional

When this option is selected, the
height and width of the job are
increased or decreased together to
keep the original proportions intact.

Fit to Media

Increases or decreases the job
proportionally to fit maximum width of
the output device.

Copies

Sets the number of copies of the job to be printed.

Layout

These settings change the position of the image on the
media.
Select this option to output the job at the
machine's origin on the edge of the media.
Select this option to output a job in the
center of the media.
Select this option to output the job in the
center of a sheet of media.
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After
Output

Offset V

Select this option to set a vertical offset
distance from the machine's origin.

Offset H

Select this option to set a horizontal offset
distance from the leading edge of the media.

Spacing

This is the amount of space given between
each tile or copy.

This determines what is done with the job after output.
Delete

Removes the job.

Hold

Places the job back in the Hold Queue.

Archive

Stores the job in the archive folder set in
the Preferences dialog box.

Job Properties - Print Tab
Media

Select the type of media you are outputting onto.

Print Mode

Select the desired quality of your print. This setting will
vary for each type of printer.

Resolution

Choose an appropriate DPI (dots per inch) for your job.
A higher DPI value improves the resolution of the job,
but slows down the output. Higher DPI values may not
be necessary for all jobs.

Driver
Options

Clicking this button launches the Driver Options dialog.
The settings in Driver Options will vary depending on
your output device. Some common driver options
include.
Enable driver
options

Allows you to use the available
driver options for your output
device. When driver options are
enabled, you can set special
options from within the driver
options dialog. When driver options
are disabled, the default options
will be used.

Passes/
Enhanced mode/
Banding method

Sets the number of passes made
by the print heads on the printer.
This setting determines the number
of pixels that the printer advances
between passes. The higher the
setting the less the printer
advances between passes.

Processing Print Jobs
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Print direction/
Print mode

Direction the print heads move
when printing. In Bi-directional
mode the print cartridges print from
left to right, then from right to left.
In unidirectional mode, the
cartridges print from right to left
only. Bi-directional mode prints
faster, but unidirectional mode
usually produces a better quality
print.

Dry time

This is the amount of time the
printer waits after it has completed
printing, allowing the ink to dry.

Firing rate/
Carriage speed

The speed at which the print heads
fire. The faster the print heads fire,
the faster the device prints, but a
faster firing rate may result in a
lower quality print.

Cut after print

Cuts the media after the print is
complete. If a drying time has been
set, the media will be cut after the
dry time is finished.

Microweave

A higher quality printing option,
which interlaces the passes while
printing.

Enhanced
resolution

Allows the printer to simulate a
higher resolution.

Enable varware

A particular setting, which controls
print quality and speed. Available
only for a particular brand of
printer.

Pile up/
Overprint

Number of times you would like the
printer to print over the same area.
This setting increases the number
of ink layers placed on the media.

Dither Type

Sets the dither type to be used by the print job.
See “Dither Types” on page 9 for details.

Screen

This button is enabled when Angled Screen is selected
in the Dither type. It allows you to specify the screen
frequency, angle and shape for each color channel.

Perform
Color
Correction

Checking this setting activates the color correction
settings. If this setting is not checked, incoming jobs are
assumed to already have color correction.
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Use
embedded
ICC profile

Checking this option forces the RIP to use the ICC
profile information embedded in the job file.

ICC input
profile

Input profiles are used to convert the image into a
neutral color space.
See “ICC Input Profile” on page 10 for details.

ICC output
profile

Select the ICC profile that matches the combination of
ink, media, resolution, and dither type of your output
device.
See “ICC Output Profiles on page 10 for details.

Bitmap and
Vector
rendering
intent

Select the bitmap and vector rendering intents to be
used.
See “Bitmap and Vector rendering intent” on page 10 for
details.

Color Mode

If your output device supports multiple color modes, then
you can select one of the supported color modes here.

Job Properties - Cut Tab
Use the Cut tab to display and edit information for contour cut jobs. This
tab will only be displayed when a contour job is selected. Cut properties
include all settings related to cutting and plotting.
See “Setup Properties – Cut Tab” on page 12 for details.
Job Properties - Color Tab
The Color tab provides you some basic tools to manually adjust the
output color.
See “Setup Properties – Color Tab” on page 13 for details.
Job Properties - Job Preview Panel
In the job preview panel of Job Properties you may use the following
tools:
•

Select an object

•

Zoom tool

•

Zoom to page
Preview - Layout, Panel, Page
Page - If the job has multiple pages use this setting to see the
other pages.

Selecting Jobs
Multiple jobs can be selected using the standard Windows CTRL and
SHIFT methods.
Processing Print Jobs
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To select all the jobs in a queue, open the Edit menu and select Select
All.

Sending Jobs to the Output Device
To send a job to the output device which has been set up, select the job
and do one of the following:
•

Open the File menu and select Send.

•

Click on the Send icon in the toolbar.

The job will automatically be RIPed then output.

Aborting the Processing of a Job
To abort the processing of a job while it is being sent:
1.

Select the job.

2.

From the File menu, select Abort or click on the Abort button in
the toolbar.

Deleting a Job
To delete a job, select the job and do one of the following:
•

Press the Delete key on your keyboard,

•

From the Edit menu, select Delete.

•

Click the Delete icon on the toolbar.

Using RIP Logs
Each time a job is RIPed, an entry for that job is added to the RIP Log
for that output device. The RIP Log entry lists the relevant details about
the job: where it came from, its basic characteristics, what job properties
were set, and the time at which it started and finished RIPing.

Viewing RIP Logs
To view the rip log for a given output device:
1.

Select the setup icon for the output device.

2.

From the View menu, select View RIP Log.

The RIP Log is formatted as an HTML file, and displays in the default
browser for the operating system.

Clearing RIP Logs
To clear out the rip log for a given output device:
1.

Select the setup icon for the output device.

2.

From the View menu, select Clear RIP Log.
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Exiting the Software
Under normal operation, the software loads automatically each time the
OS is restarted (using a shortcut in the Startup folder) and runs
minimized, displaying an icon in the system tray area of the Windows
taskbar.
The software is designed to run all the time the computer is operating.
“Exiting” the software by clicking on the Close button in the title bar
merely cause the software to be minimized.
To actually exit the software, from the File menu select Exit, or rightclick on the software icon in the system tray and select Exit from the
context menu.

Processing Print Jobs
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4. Maintenance and Uninstalling
Clear Preferences
Clear Preferences is a utility that removes all output device setups and
returns the software to its default settings. It is particularly helpful when
troubleshooting any problems you may encounter with your software.
To clear the preferences stored in your system:
1.

Exit the software.

2.

Browse through the Windows Start menu to the folder for the
software and click on the Clear Preferences utility.

3.

Select Yes when you are asked if you would like to clear your
preferences.

Install Password
The Install Password utility helps you manage the different passwords
that come with the software. After you have installed the basic program
with your main password, you should then launch the Password Installer
to add any additional passwords you may have.
Application Password - This is your main application password for
software.
Option passwords- If you have purchased additional options, you may
enter the option passwords to this field to upgrade your software.
Make sure that the software is not running when you add a new password.

To add additional passwords:
1.

Browse through the Windows Start menu to the folder for the
software and click on the Install Password utility.

2.

Add your additional passwords to the optional password section by
clicking the Add button, and entering the password into the dialog.

3.

When you have finished, your password should appear in list in the
optional password field.

Maintenance and Uninstalling
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Uninstalling the Software
Windows Uninstall
1.

Exit your software by selecting Exit from File menu, then rightclicking on the software icon in the system tray and selecting Exit.

2.

In the Windows Control Panel, double-click the Add/Remove
Programs icon.

3.

Select your software from the list and click the Change/Remove
button.

4.

Click OK when finished.

5.

Delete the folder on your hard drive that the software was installed
into (C:\Program Files\[Software], for example), then empty the
Windows recycling bin.

Macintosh Uninstall
4.

Quit the software.

5.

Drag the software folder into the Trash.

6.

Open the System folder.

7.

From the Preferences folder, drag the ‘Preferences’ and ‘Prefs’ files
for the software into the Trash.

8.

Locate and open the Extensions folder. Drag the spooler file into
the Trash. The Spooler file is named according to your printer, and
appears as Am_<printer name>, depending on the printer
installed. From the Printer Descriptions folder, located within the
Extensions folder, drag the PPD files, named according to your
output device, into the Trash.

9.

Restart your computer.

10. Hold down the Option key while you empty the Trash. The
software is now uninstalled.
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Appendix A: Supported File Types
The software supports the following file formats:
File Format

Extension

Import

Export

Joint Photograph
Experts Group (JPEG)

jpg

*

N/A

Tag Image File Format
(TIFF)

tif

*

N/A

pdf

1.3

N/A

ps, EPS, 2ps, fjb, prn

3.0

N/A

bmp

*

N/A

prt, plt

*

*

Plot / Cut Job Files

job

*

*

Print Job Files

fjb

7.0

N/A

Kodak PhotoCD

pcd

*

N/A

Portable Document
Format (PDF)
PostScript
Windows bitmap
Native Files

* Version number does not exist or is not applicable.
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Index
aborting RIP or output
5, 22
active setup
7
angled screen dithering
11
application preferences
15
automatic loading at startup 2
banding method
20
bitmap rendering intents 12, 21
carriage speed
20
color
adjusting
14, 21
correction
11, 21
modes
13, 21
communication
14
contour cutting
13, 21
Creating a Desktop Printer
3
cut after print
20
deleting jobs
5, 22
dithering
10, 20
dongle
See Hardware Key
dry time
20
enhanced mode
20
error diffusion
10
exiting the software
2
file types
27
firing rate
20
FMXPress diffusion
10
Hardware Key
2
holding printed jobs
15
hot folders
17
ICC input profiles
11, 21
ICC output profiles
12, 21
Install Password utility
25
Installation
2
Installing AdobePS Driver for a
Macintosh
3
job properties
interaction with other
settings
17
jobs
aborting
22
adding
5, 17
archiving
19
contour cutting
21
deleting
5, 22
dithering
20
Index

fitting to media
18
media type
19
outputting
5, 22
previewing
21
priority
9
saving to file
5
selecting
22
KF diffusion
10
license agreement
ii
License Agreement
2
LX diffusion
10
media type
19
microweave
20
network printers
7
number of copies
18
number of passes
20
options
application preferences 15
how options interact
17
job properties
17
setup properties
8
ports
8
preferences
application
15
clearing
25
print direction
20
print mode
19, 20
printing
22
random diffusion
10
rendering intents
12, 21
resolution
10, 19
RIPing
simultaneous RIP and print
15
saturation
12
screen
11, 21
server preferences
interaction with other
settings
17
setup properties
interaction with other
settings
17
setups
6
adding
6
color
14
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communication
cutting
deleting
desktop printers
editing
selecting
simultaneous RIP and print
spot color
rendering intent
Startup folder
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14
13
7
7
8
7
15
13
2

System requirements
1
system tray icon
2
toolbars
5
uninstalling the software
26
units of measurement
15
vector rendering intents 12, 21
Windows NT/2000
administrator privileges
needed for installation
2

Index

